
UG459: Si83xx SPI Motherboard User Guide

Introduction

This User Guide explains the features of the Si83xx SPI 
Motherboard, DCs (daughtercards), I/O, and 
accompanying software - the Skyworks Industrial I/O 
Control Panel. Together, this hardware and software 
system enable the user to evaluate Skyworks’ Si834x 
and Si838x Industrial I/O products by leveraging their 
SPI daisy chain capabilities.

The motherboard comes with one of three different 
daughtercard options: Si834xSRC SPI DC, Si834x SNK 
SPI DC, or the Si838x SPI DC. These stackable 
daughtercards allow the user to serially connect up to 
four devices at a time. The Skyworks Industrial I/O 
Control Panel runs on a host PC and interfaces with the 
motherboard and target devices via USB connection.

Each Si834x DC comes equipped with four output 
channels that meet IEC 61131-2 requirements for 0.5 A 
outputs, and each Si838x DC comes equipped with eight 
input channels that meet IEC 61131-2 requirements for 
input channels. More information on these parts can be 
found in the Si834x data sheet and Si838x data sheet.

EVB Contents

• Si83xx SPI Motherboard
• One or more of the following daughtercards:

- Si834xSRC SPI DC
- Si834xSNK SPI DC
- Si838x SPI DC

• Micro-USB cable
• 24 V, 2.1 A power supply with universal adapters
• Stackable through-hole connectors that enable SPI 

daisy-chaining
• Pluggable output terminal blocks
• Reverse supply protection
• Supply overvoltage protection
• Output channel surge protection (Si834x DCs)
• IEC 61131-2 compliant output channels 

(Si834x DCs)

• IEC 61131-2 compliant input channels (Si838x DCs)
• Test points and LED indicators for simple 

evaluation
• Skyworks Industrial I/O Control Panel software for 

intuitive device control

Ordering Information

Motherboard and daughtercard:

• Si83408ADA-KIT
• Si83418ADA-KIT
• Si8380S-KIT

Daughtercard only:

• Si83408ADA-DC
• Si83418ADA-DC
• Si8380S-DC

Figure 1. Si83xx SPI Motherboard and Daughtercards
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1.  System Overview

The Si83xx SPI Motherboard (MB) and Daughtercard (DC) system can be broken down into three main parts: the 
daughtercards, the motherboard, and the software GUI. The GUI will receive user input, interface with the device 
stack (comprising 1 to 4 DCs), and display register data and device statuses for the user. The high-level system 
block diagram can be seen in the following figure.

Figure 2. System Block Diagram

The system contains two isolated power domains: a low-voltage logic side and a high-voltage field side. The 
low-voltage domain is sourced externally by the USB 5 V connection and powers the onboard MCU and the logic 
side of the Si83xx devices in the stack. The high-voltage domain is sourced externally by the 24 V wall wart PSU 
provided in the EVB kit. The field supply powers the field side of any Si834x devices in the stack, and it also 
provides a high-voltage source for direct connections to the Si838x field-side input channels. If desired, the user 
may provide their own logic supply (3.3 to 5 V) or field supply (9 to 32 V) using the J13 and J10 terminal blocks, 
respectively. Any loads connected to the Si838x input channels or the Si834x output channels must also be 
connected externally, as no loads are provided on the daughtercards. For full instructions on how to configure the 
hardware, see “2. Hardware Configuration” on page 4.
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The Industrial I/O Control Panel is a Python-based graphical user interface (GUI) that must be installed and run on 
a computer running the Windows 10 operating system. This program was designed to control the Si83xx SPI MB 
and up to 4 DCs (minimum 1). The USB connection from the PC to the MB provides logic power to the board and a 
virtual COM port (VCP) for transacting data between the software and the controller. Detailed instructions on how 
to install, run, and operate the software program can be found in “3. Getting Started with the Skyworks Industrial 
I/O Control Panel” on page 11.

The MCU on the motherboard is an 8-bit MCU that functions as a USB to SPI bridge. The MCU receives USB com-
mands from the Control Panel that are converted into 3-byte SPI packets and sent to the device stack. These SPI 
packets utilize 4 wires – SCLK, NSS, MOSI, and MISO – and are comprised of a control byte, address byte, and data 
byte. Data is sent from the MCU to device 0 first, then daisy-chained to each subsequent device by replacing the 
MOSI signal with MOSI-thru. The output enable (OE) pin is driven to all devices in the stack simultaneously. All 
Si834x fault (FLT) outputs are wire OR’ed together and sensed on a single input pin of the controller.
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2.  Hardware Configuration

The Si83xx-SPI-MB EVB motherboard (MB) was designed to evaluate the SPI functionality of different 
daughtercards (DCs) including the Si838x and Si834x ICs through the J1–J4 headers. Up to four different DCs can 
be attached to the motherboard. The following daughtercards are available for evaluation:

• Si834xSRC-SPI-DC
• Si834xSNK-SPI-DC
• Si838x-SPI-DC

The motherboard contains two domains: a supply for the low-voltage logic side which also powers the 
microcontroller, and a high-voltage field side. The two domains are separated by an isolation barrier. 
Each power rail is led through the connectors to the daughtercards; therefore, power should be supplied only to 
the motherboard.

2.1.  Microcontroller Domain (VDD1)

On the logic side, there are two different options to supply power to the microcontroller. It can be done by:

• Connecting a micro-USB cable through the J5 micro-USB connector, or by
• Connecting a bench power supply unit through the J13 plug

The voltage of VDD1 must be between 3.6 V and 5.25 V. In order to interact with the GUI, a micro-USB cable must 
be connected to the MB at all times.

The jumpers on J17 and J20 must be aligned with the source of power: If micro USB connector J5 is used, the 
jumpers need to be in position 1-2, while if the external connector J13 is used, both of the jumpers should be set 
to position 3-4.

The two possible power supply and jumper configurations regarding the above-mentioned setups are shown in 
the following table:

2.2.  Field Domain (VDD2)

There are also two different options for supplying power to the output side. These are:

• Connecting a bench power supply unit through the J10 plug, or
• Connecting an adapter through the J14 DC barrel jack

The voltage of VDD2 must be between 9 V and 32 V.

Note:
Any combination of Si834x and Si838x DCs may be placed in the stack during evaluation. At least one DC 
must be used at all times, and a maximum of four DCs may be used at one time. The Si838x DCs must 
always be placed on top of any Si834x DCs in the stack.

Table 1. Power Supply and Jumper Configurations

Power Source Connector J17 and J20 Position Acceptable Voltage Range

+5 V from USB cable J5 Pin 1-2 5 V

Bench Power supply J13 Pin 3-4 3.6 ~ 5.25 V
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2.3.  LED Indicators

There are various visual indicator LEDs on both the MB and DCs. The following sections gives a quick description 
about these LEDs for each board in the kit:

Si83xx-SPI-MB

• D13: orange visual indicator of the VDD1 power rail
• D14: blue visual indicator of the VDD2 power rail
• D4: green visual indicator of the USB connection
• D1: red visual indicator of the fault pin (FLT)
• D2: green visual indicator of the ready pin (RDY)

Figure 3 shows the connectors and the indicator LEDs on the Si83xx-SPI-MB Rev 2.0.

Figure 3. Si83xx-SPI-MB Rev 2.0 Connectors and LED Indicators
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Si838x-SPI-DC

• D10: orange visual indicator of the VDD1 power rail
• D9: blue visual indicator of the VDD2 power rail
• D1 to D8: yellow visual indicators of the eight different input channels

Figure 4 shows the connectors and the indicator LEDs on the Si838x-SPI-DC Rev 2.0 Daughtercard.

Figure 4. Si838x-SPI-DC Rev 2.0 Connectors and LED Indicators

Although the Si838x-SPI-DC has a VDD2 indication LED, this voltage rail is not used on the daughtercard. As this is 
designed to be a PLC input device, power is provided to each channel input by an external source.
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Si834xSRC-SPI-DC

• D7: orange visual indicator of the VDD1 power rail 
• D8: blue visual indicator of the VDD2 power rail 
• D1: red visual indicator of the fault pin (FLT) 
• D2-D5: green visual indicators of the four different output channels in sourcing configuration

Figure 5 shows the connectors and the indicator LEDs on the Si834xSRC-SPI-DC Rev 2.0 Daughtercard.

Figure 5. Si834xSRC-SPI-DC Rev 2.0 Connectors and LED Indicators
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Si834xSNK-SPI-DC

• D7: orange visual indicator of the VDD1 power rail
• D8: blue visual indicator of the VDD2 power rail
• D1: red visual indicator of the fault pin (FLT)
• D2 to D5: green visual indicators of the four different output channels in sinking configuration

Figure 6 shows the connectors and the indicator LEDs on the Si834xSNK-SPI-DC Rev 2.0 Daughtercard.

Figure 6. Si834xSNK-SPI-DC Rev 2.0 Connectors and LED Indicators

It is important to note that the fault signal of all DCs are connected together using open-drain buffers and fed to 
MB. Therefore, this LED indicates a fault on any of the DCs. The Si838x devices do not have a fault output, so this 
indicator (and the one on the MB) will only be present when Si834x DCs are used.
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2.4.  Load Configurations

The following figures show how to configure Si838x-SPI-DC as a PLC Input Module as well as typical load 
configurations for the Si834x-SPI-DC Rev 2.0 Daughtercards. For further details, please refer to the corresponding 
user guides: “UG206: Si838xISO-EVB User’s Guide” and “UG390: Si834x-EVB User Guide”.

Figure 7. Si838x-SPI-DC Rev 2.0 Input Configuration

Figure 8. Si834xSNK-SPI-DC Rev 2.0 Connectors and LED Indicators
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Figure 9. Si834xSRC-SPI-DC Rev 2.0 Connectors and LED Indicators
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3.  Getting Started with the Skyworks Industrial I/O Control Panel

The Si83xx SPI motherboard (MB) and daughtercard (DC) system comes with a downloadable software program 
called the Skyworks Industrial I/O Control Panel, or simply “Skyworks IICP”. This program is only compatible with 
the Windows 10 operating system at this time. The program provides a GUI interface to the Si83xx Industrial I/O 
isolator devices contained in the device stack. The Si83xx product family, which consists of the Si834x Isolated 
Smart Switch devices and Si838x Bipolar Digital Input devices, are enabled with the SPI daisy chain capability. This 
feature allows the SPI controller to interface with multiple devices (up to 16 of the Si838x and up to 32 of the 
Si834x) utilizing a single SPI bus. 
In this way, the MCU on the Si83xx SPI MB interfaces with up to four devices in the device stack simultaneously 
and provides constant feedback to the GUI for user interaction.

3.1.  GUI Installation

In order to install the Skyworks Industrial I/O Control Panel (the “software” or “program”), navigate to the 
Si83xx-SPI-MB Portfolio page and download the skyworks_iicp_setup.zip file. Extract the contents of the file to 
your hard drive, and run the Skyworks_Industrial_IO_setup.exe file, clicking “Yes” if prompted, whether or not 
you wish to run the program. Click “Next” through the prompts, modifying the installation settings as desired. 
Uncheck the “Launch..” checkbox on the last step, then click “Finish”.

3.2.  USB Driver Installation

Before continuing with setup, ensure that the Silicon Labs CP210x Universal Windows Driver has been installed. 
The driver can be downloaded from this website. Once the driver is installed, the PC must be restarted.
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3.3.  Configure App to Run as Administrator

If the program was installed in the default directory of “C:\Program Files (x86)\Skyworks\”, then you will need to 
run it with administrator privileges in order to use all of the features of the program. You can set the program to 
run as administrator by default. To do this, navigate to the installation folder, right click on the “Skyworks Indus-
trial I/O Control Panel.exe”, and click Properties.

1. Navigate to the installation folder and find the executable file. Right click the .exe and click Properties.

Figure 10. Skyworks IICP Installation Directory
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2. Navigate to the Compatibility tab, check the “Run this program as an administrator” box, and click OK.

Figure 11. Skyworks IICP Properties Window

Once the installation process is complete, move on to the next section to learn how to connect the motherboard.
Skyworks Solutions, Inc.   •   Phone [949] 231-3000   •   sales@skyworksinc.com   •   www.skyworksinc.com

206637C   •   Skyworks Proprietary Information   •   Products and Product Information are Subject to Change without Notice

13 July 9, 2024



Si834x/Si838xUSER GUIDE
3.4.  Connecting to the Motherboard

When running the Skyworks Industrial I/O Control Panel, you will be greeted with the home screen shown in 
Figure 12 below, also known as the “Main GUI View”. This section provides an overview of the home screen and 
how to initialize a USB connection to the motherboard. The following sections and subsections will go into more 
detail about the various widgets and features within the program.

The Main GUI View will be relatively empty, as shown in Figure 12 below, before a motherboard is connected. To 
connect the motherboard, we will use the motherboard “widget”, which is another name for the portion of the 
program dedicated to a particular interface. This term will be used throughout the following sections. The 
motherboard widget with markers is highlighted in purple.

Figure 12. Motherboard Widget with Feature Markers
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The MB widget has several features that will help you establish a USB connection to the motherboard, monitor 
the board’s status, and more. Table 2 identifies and describes each of the eight highlighted features in Figure 12 
above.

Before initiating the USB connection to the motherboard, first ensure that the board is configured properly as 
explained in “2. Hardware Configuration” on page 4. Once the board is configured properly and connected to the 
PC, click “Refresh VCP” to ensure that the board is detected. Click on the device list drop-down (#4) and find the 
“Silicon Labs CP210x USB to UART Bridge” and click on it. If pop-ups are enabled and the connection is 
established, a dialogue will open that says “Success!”, and the connection status will change from “Disconnected” 
to “Connected”. If the MCU does not appear in the drop-down list, return to 3.2. USB Driver Installation above and 
ensure that the correct USB driver is installed. Correct installation can be verified by navigating to Device Manager 
and confirming that “Silicon Labs CP210x USB to UART Bridge” is listed under Ports.

3.5.  Using the Built-In Test Program

Once the software has loaded and the motherboard is connected, it is recommended to run the built-in test program to 
verify the functionality of the MB and DCs. Once the test program completes successfully, the user should be confi-
dent utilizing all features of the Skyworks Industrial I/O Control Panel.

3.5.1. Motherboard Test Program

Navigate to the Quick Start menu and click on Test Program to begin. If the hardware is configured improperly or 
polling is disabled, running the test program will result in a warning. The following list describes each possible 
warning and its meaning:

1. Polling enabled—No action required; this informs the user that polling was enabled for the test program.

2. No motherboard—Indicates that no MB is connected. Double-check that each step in “2. Hardware Config-
uration” on page 4 was followed correctly and verify that the “Motherboard:” status indicator in the MB 
widget
indicates “Connected” before trying again.

3. No devices detected—Indicates that no DCs were detected in the device stack. If this is correct, and only 
the MB is being tested, then click “Yes” and proceed. If there are DCs in the stack that did not get detected, 
then revisit 2. Hardware Configuration before trying again.

4. Invalid config—Indicates that the current stack configuration is invalid. Double-check that the instructions 
in the stack configuration note in 2. Hardware Configuration were followed to configure the stack properly, 
and then try again.

Table 2. Motherboard Widget Features

Number Feature Description

1 Connection status Displays whether motherboard is currently connected

2 Pop-up checkbox Toggles pop-up notifications for MB widget

3 Refresh all button Refreshes status of MB and all devices

4 VCP connection and device list Displays current VCP connection and available devices

5 Refresh VCP button Refreshes list of available VCP devices

6 Si83xx device list Displays all Si83xx devices currently connected to the MB

7 Motherboard status Displays “fault” and “valid config” status bits

8 OE button Toggles the “output enable” signal to the device stack
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Once the test program is loaded, the Si83xx SPI MB Test Program window will open as shown in Figure 13. 
Verify that the “Si83xx Device List” in the upper righthand corner matches your device stack. Click “Begin” and 
choose “Yes” to initiate the test program. Follow the prompts for each step, using the buttons to navigate through 
the test program. Once the MB test program is complete, click “Finish” to move on to the test program for the first 
device in the stack.

Figure 13. Si83xx SPI MB Test Program Window
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3.5.2. Si834x DC Test Program

Once the MB test program is complete, the test program will advance to the first device in the stack. If the Si834x 
DC is the next DC in the stack, the Si834x SPI DC Test Program window will open as shown in Figure 14. The 
“Device: x/y” counter at the top should reflect the position of the current device in the stack, with 1 being the first 
and 4 being the last (depending on how many DCs are connected).

Click “Begin” and choose “Yes” to initiate the Si834x SPI DC Test Program. Follow the prompts for each step, 
ensuring that the output channels toggle as indicated in the instructions. Once the Si834x test program is 
complete, click “Finish” to move onto the next device's test program.

Figure 14. Si834x SPI DC Test Program Window
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3.5.3. Si838x DC Test Program

If the device being tested is an Si838x, the Si838x SPI DC Test Program window will open as shown in Figure 15 
below. Click “Begin”, and choose “Yes” to initiate the Si838x SPI DC Test Program. Follow the prompts for each 
step, ensuring that the register values change per the instructions. Once the test program is complete, click 
“Finish” to move on. Once the last device in the stack is tested, a dialogue box will appear with the results of each 
test program.

Figure 15. Si838x SPI DC Test Program Window
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4.  Using the Skyworks Industrial I/O Control Panel

Once the test program is complete, you will return to the home screen of the GUI. This section provides a 
walk-through of each program feature.

4.1.  Navigating the Main GUI View

If the instructions in 3.4. Connecting to the Motherboard were followed correctly and the MB is connected, then 
the GUI will automatically detect the connected DCs and populate the window with the correct device widgets 
and their corresponding register view. Figure 16 shows what the updated Main GUI View will look like. 
The colored boxes and number markers designate the different features:

Figure 16. Main GUI View with Motherboard Connected
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The home screen is broken down into six main widgets, although some of these sections contain additional wid-
gets or features in themselves and are explained in more detail later on. Table 3 identifies each widget of the Main 
GUI View and their purpose in the program.

The various menus and actions contained in the Toolbar (1) will be explained as needed throughout the following 
sections. A detailed explanation on how to use the Si834x and Si838x device widgets contained in the Device 
Stack (2) can be found in Sections 4.2. Using the Si834x Device Widget and 4.3. Using the Si838x Device Widget. 
Section “4.4. Additional Features” on page 25 will discuss the remaining features (3, 4, 6).

4.2.  Using the Si834x Device Widget

The Si834x Device Widget is the primary tool for interfacing with any Si834x devices in the device stack. Each 
Si834x DC will have its own widget. The widgets will populate the Main GUI View from bottom to top, as shown in 
Figure 16.

Each widget contains the same three primary features: the Device Number Block, Channel Output Control, and 
Fault Control. These are highlighted in blue, purple, and red, respectively, as shown in Figure 17 below.

Figure 17. Si834x Device Widget

Table 3. Main GUI View Widgets

Number Widget Description

1 Toolbar Contains global option and feature menus

2 Device Stack Provides primary interface to Si83xx devices

3 Register View Displays current register values for devices in the stack

4 Command Log Displays a history of SPI commands sent to the device stack

5 Motherboard Provides primary interface to Si83xx MB

6 Polling Settings Configures device polling settings 

Table 4. Si834x Device Widget Features

Number Feature Description

1 Device Number Block Contains device address, refresh button, and pop-up box

2 Channel Output Control Contains buttons that toggle output channels

3 Fault Control Contains interface for fault config and status registers
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4.2.1. Device Number and Channel Control

The Device Number Block feature (see Table 4, Number 1) contains the order of the device in the SPI daisy chain 
(device stack) starting with 0 and increasing up to 3. There is also a description of the isolator device type, a 
refresh button, and a checkable box for pop-ups.

The “Refresh Device” button is used to manually poll the device stack to refresh this particular device’s data. 
If polling is disabled, the widget display can be desynchronized from the device’s actual state on the daughtercard 
(see “4.4.1. Polling Settings” on page 25 for more on polling). In this case, pressing the refresh button will 
resynchronize the display with the device data. The pop-up checkbox is used to enable or disable informational 
pop-up messages, which are disabled by default.

The Channel Output Control feature (see Table 4, Number 2) contains four pushbuttons that toggle the 
corresponding channel on the Si834x device. Pushing the “CHx” button will assert the corresponding bit in the 
SW_EN register (SPI register 0x3, bits [3:0]). If the channel is able to turn on, the pushbutton will turn green and 
the text will change to “ON”. It is important to note that the pushbutton display corresponds to the actual switch 
status, or the 4 bits contained in the SW_STAT register (SPI register 0x3, bits [7:4]). The channel may not turn on 
for the following reasons:

• The device is self-protecting from over-temperature
• The device is self-protecting from undervoltage on the VDD1 or VDD2 supply
• The device is self-protecting from an overload on the channel
• The device is experiencing a communication error
• Output Enable (OE) is being driven low (outputs disabled)

If the condition preventing the channel from turning on is removed, then the output will turn on and the button 
display will update the next time the device widget is refreshed (either manually or by polling). For more detailed 
information on the device’s self-protection and output channel behavior, refer to “3. Device Operation” in the 
Si834x datasheet.

4.2.2. Fault Control

The Fault Control feature (see Table 4, Number 3) provides an interface for configuring, monitoring, and clearing 
diagnostic reports (referred to as “faults” for simplicity) in the Si834x diagnostic control registers. All of the 
buttons in the Fault Control block perform the same set of functions on the seven different fault types which are 
described in Table 5.

There are four columns in the fault control block: Fault Enable, Autoclear Enable, Manual Clear, and Status. Each 
of these corresponds to a different register or set of registers in the Si834x SPI register map and provides a unique 
function.

Table 5. Si834x Fault Types

Number Fault Description

1 COMM_ERROR Communication Error (all channels shut down)

2 OT_SD All Channels Over-Temperature (all channels shut down)

3 VDD2_OS VDD2 Out of Specification

4 VDD2_LOW VDD2 Low Voltage (warning)

5 OC_SD Over-Churrent Shutdown (channel-specific)

6 OT_CNS Over-Temperature Constraint (channel-specific)

7 OPEN_WRN Open-Circuit Warning (channel-specific)
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The pushbuttons in the “Fault EN” column allow the user to toggle the corresponding bit mask in the FLT_EN 
register (SPI register 0x6). This enables or disables each fault type from being brought out on the FLT pin of the 
Si834x. This is the equivalent of adding or removing the chosen fault signal from an OR gate whose output drives 
the FLT bus. If all seven faults are disabled in the “Fault EN” column, then none of the corresponding faults will 
assert the FLT pin. If all seven faults are enabled, then any of the corresponding faults will assert the FLT pin. Note 
that enabling or disabling a fault in the “Fault EN” column does not affect whether the fault is asserted in the cor-
responding fault register, only if that report is brought out onto the FLT output pin of the Si834x device. All seven 
faults can be enabled or disabled simultaneously using the “EN All” checkbox. These buttons will be green when 
enabled and grey when disabled.

The pushbuttons in the “Autoclear EN” column allow the user to toggle the corresponding bit mask in the 
ACLR_EN register (SPI register 0x7). This enables or disables each diagnostic report from being autocleared in the 
corresponding diagnostic register. When autoclear is enabled for a particular fault, the corresponding bit will be 
reset from a 1 to a 0 whenever the fault is removed. When disabled, the corresponding bit will remain a 1 until a 
manual clear is applied using the CLR_DIAG register. For channel-specific faults such as open-circuit warning or 
over-temperature constraint, enabling autoclear applies to all of the corresponding faults for all four channels. 
Autoclearing for all seven faults can be enabled or disabled simultaneously using the “ACLR All” checkbox.

The pushbuttons in the “Manual Clear” column allow the user to assert a 1 to the corresponding bit mask in the 
CLR_DIAG register (SPI register 0x5). These buttons are only enabled when the corresponding “Autoclear EN” 
buttons are disabled, as shown in Figure 18.

Figure 18. Si834x Autoclear All Enabled (Left) and Disabled (Right)

All seven faults can be cleared simultaneously using the “CLR All” button. These buttons will have bold black text 
when enabled and will be grey when disabled.

Each of the fault control features is designed to reproduce the functionality of the corresponding diagnostic regis-
ters in the Si834x SPI register map. The user is strongly encouraged to read Sections 3.5 and 3.6 of the 
Si834x Data Sheet to fully understand the functionality of the diagnostics and monitoring system and the Serial 
Peripheral Interface of the Si834x.
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4.3.  Using the Si838x Device Widget

The Si838x Device Widget is the primary tool for interfacing with any Si838x devices in the device stack. Each 
Si838x DC will have its own widget, and the widgets will populate the Main GUI View from top to bottom, as 
shown in Figure 16. Recall that Si838x devices must always be placed after (on top of) any Si834x devices in the 
stack.

Figure 19. Si838x Device Widget

Each Si838x widget contains the same three primary features: the Device Number Block, Individual Channel Dis-
play and Control, and Grouped Channel Control. These are highlighted in orange, yellow, and green, respectively 
in Figure 19 above.

4.3.1. Device Number

As with the Si834x device widget, the Device Number Block (see Table 6, #1) contains the order of the Si838x 
device in the SPI daisy chain starting with 0 and increasing to 3. There is also a description of the isolator device 
type, a refresh button, and a checkable box for pop-ups.

The “Refresh Device” button is used to manually poll the device stack to refresh this particular device’s data. If 
polling is disabled, the widget display can be desynchronized from the device’s actual state on the daughtercard 
(see “4.4.1. Polling Settings” on page 25 for more on polling). In this case, pressing the refresh button will resyn-
chronize the display with the device data. The pop-up checkbox is used to enable or disable informational pop-up 
messages, which are disabled by default.

Table 6. Si838x Device Widget Features

Number Feature Description

1 Device Number Block Contains device address, refresh button, and pop-up box.

2 Individual Channel Display and Control Contains channel status indicators and DBNC Mode/Delay buttons.

3 Grouped Channel Control Provides buttons for simultaneous control of DBNC Mode/Delay for all channels.
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4.3.2. Channel Status Indicators

The Si838x channel status indicators form the top row of widgets in the Input Channel Display and Control feature 
(see Table 6, #2). Although they share a similar appearance with the channel control buttons of the Si834x device 
widget, these indicators are not buttons at all. Unlike the Si834x, the Si838x data channels cannot be toggled off 
and on. Instead, they are passive inputs that will energize when an external 24 V source is properly applied. 

When an external input source is connected to a channel, the corresponding bit will be set to 1 in the CHAN_STA-
TUS register (SPI register 0x0). When the device is next refreshed, the corresponding channel indicator will turn 
green, as shown by the CH5 indicator in Figure 19 on page 23. When the input source is disconnected, the corre-
sponding bit will be set to 0 in the CHAN_STATUS register, and the corresponding channel indicator will revert to 
gray with red text (see Figure 19). For more information on how to properly apply an external source to the 
inputs, refer to “2.4. Load Configurations” on page 9.

4.3.3. Individual and Grouped Debounce Control

The debounce mode and delay can be individually configured for each of the eight input channels of the Si838x 
using the Individual Channel Control (see Table 5, #2) feature. In order to enable individual control, the “DBNC 
Delay ‘All Channels’” and “DBNC Mode ‘All Channels’” checkboxes must be unchecked. Once unchecked, the 
“DBNC Mode” and “DBNC Delay” rows will become enabled as shown in Figure 19. Each channel has the same set 
of mode and delay options. Debounce mode can be set to “Deglitch”, “Low-Pass”, or “Blanking". Debounce delay 
can be set to 0, 10, 30, or 100 ms. These options are shown in Figure 20.

Figure 20. Si838x Debounce Mode Options (Left) and Debounce Delay Options (Right)

When the debounce mode setting for a particular channel is changed, the corresponding bits are modified in the 
DBNC_MODE0 register (SPI register 0x1) for Channels 1 through 4 or the DBNC_MODE1 register (SPI register 0x2) 
for Channels 5 through 8. Likewise, when the debounce delay setting is changed, the corresponding bits are mod-
ified in the DBNC_DLY0 register (SPI register 0x3) for Channels 1 through 4 or the DBNC_DLY1 register (SPI register 
0x4) for Channels 5 through 8. The specific bit values that are written depend on the option selected and can be 
found in Section 3.6.1 of the Si838x data sheet.

If the user desires to configure all eight channels simultaneously, then the Grouped Debounce Control
(see Table 6, #3) feature can be used instead. To enable this feature, both the “DBNC Delay (All Channels)” and 
“DBNC Mode (All Channels)’” checkboxes must be checked.
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Figure 21. Si838x Group Debounce Control Buttons

When using the grouped debounce control buttons, changing the selection for DBNC Delay or DBNC Mode will 
modify the corresponding bits for all eight channels with subsequent SPI writes to either DBNC_DLY0 and 
DBNC_DLY1 or DBNC_MODE0 and DBNC_MODE1. Each of these SPI transactions is displayed in the Command 
Log, which is discussed in 4.4. Additional Features below.

4.4.  Additional Features

There are several additional features built into the Skyworks Industrial I/O Control Panel that help the user moni-
tor the SPI transactions sent to the device stack, save and load stack configurations, view register data, and more. 
These features are discussed in detail in the following subsections.

4.4.1. Polling Settings

The “Polling Settings” widget (see Table 3, #6) is a simple widget located beneath the “Command Log” that allows 
the user to toggle polling and set the polling period. When polling is enabled, all register data from each device in 
the stack will be automatically read every polling cycle. The device widgets will then be updated in the GUI to 
reflect the new data. When polling is disabled, the device widgets will have to be manually refreshed in order to 
update the register data and widget display.

Figure 22. Polling Settings Widget

To enable polling, make sure the “Polling enabled” checkbox is checked. Uncheck the box to disable polling. While 
polling is enabled, the user can adjust the polling period by clicking the up and down arrows next to “Polling 
period (ms)”, or by typing in any number between 100 and 2000. 

Note that while polling is enabled, disconnecting the USB cable or disrupting the connection between the GUI and 
the MB can cause the program to crash or encounter errors. Ensure that the USB cable remains in place at all 
times while using the GUI. Polling is enabled by default, and it is recommended to enable polling at all times while 
using the GUI. When polling is disabled, the device widgets will not update automatically and can easily be desyn-
chronized from the actual device status. When utilizing the Test Program, polling will be enabled automatically.
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4.4.2. Viewing, Saving, and Loading Board Configurations

While utilizing the program to modify device settings, the user may save the current program configuration to a 
JSON file. This config file will store the current state of each device and some of the various user settings within 
the program. This includes all device register data, the output enable state, and the enabled status of the register 
view. To save the current program config to a file, navigate to File -> Save Config or press Ctrl + S. Note that if the 
instructions in Section 3.3. Configure App to Run as Administrator were not executed correctly, Windows may not 
allow files to be saved in this folder.

The config file will be saved to “C:\Program Files (x86)\Skyworks\Skyworks Industrial IO Control Panel\configs” by 
default. The name of the config file will default to “config_dd-Mon-yy_hh-mm-ss.json” but can be be modified 
while saving or after it is saved.

Once a config has been saved, it can be loaded to restore both program settings and device register values as they 
were in the saved config file. This can be done by navigating to File -> Load Config, or pressing Ctrl + L.

To view a configuration file in a readable format, navigate to File -> View Config and select the desired config file 
from the drop-down menu. The first option will always be <current config>, which displays a snapshot of the 
current program configuration if it were to be saved.

The “View Config” widget will display the information saved to the selected config file, including:

• Number of devices connected
• Type of devices connected
• Board status (valid config [2], output enable [1], and fault [0])
• Register view and pop-ups statuses, and
• Register data for each device

This viewable format can be saved to a text file for later viewing to the same default location as the 
JSON-formatted config files.

4.4.3. Saving and Viewing Command Logs

The program contains a “Command Log” widget (see Table 3, #6) that displays a summary of each write command 
sent to the device stack by the user. Read commands are not displayed in the command log because the devices 
are constantly being polled for updated register data with each write command. The command log should be 
enabled by default, but it can be toggled on or off at any time by going to 
View -> Toggle Widgets -> Command Log. Disabling the command log does not clear the log history.

The command log tracks all user inputs that trigger a write command to be sent from the host to the MCU to the 
device stack, as shown in Figure 2, “System Block Diagram,” on page 2. After sufficient commands have been 
logged, the widget will appear with each command titled in blue, a scroll bar on the right, and the “Clear Log” 
button at the bottom.

Most commands that are displayed in the command log are formatted into the same set of four rows. Some user 
inputs will necessitate multiple writes to the device stack, in which case the command will contain five rows 
instead of four, including an extra row for the second data packet. The breakdown of a log entry is as follows:

• Row 1 (blue): device number/device type/command description
• Row 2: number of SPI writes for this command
• Row 3: control/address/data bytes in hexadecimal format  
• Row 4: total number of SPI writes issued, or second control/address/data byte for a multi-write command
• Row 5 (if applicable): total number of SPI writes issued
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The user can save the current command log to a text file at any time by navigating to Log -> Save Log.

The “View Log” widget can be opened by navigating to Log -> View Log. Once the window is open, the user can 
select the current command log or any previously saved log from the drop-down to view it. The command log can 
be cleared at any time by navigating to Log -> Clear Log or by clicking the “Clear Log” button near the bottom of 
the widget.

4.4.4. Register View and Pop-ups

The user has the option to toggle the “Register View” widget (see Table 3, #3) as well as notification pop-ups at 
any time. The register view can be enabled or disabled by navigating to View -> Toggle Widgets -> Register View 
right beneath Command Log. Each device in the stack will have its own register view table containing all register 
addresses, names, and data:

Figure 23. Si838x Register View (Left) and Si834x Register View (Right)

Pop-up notifications for each device and the motherboard can be individually toggled on or off using the 
checkboxes on their respective widget and are disabled by default. The notifications are for information only and 
are not required to operate the program. Pop-ups for all devices and the motherboard can be toggled on or off 
simultaneously by navigating to File -> Toggle Pop-ups.
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5.  EVB Schematic Files

Figure 24. Si83xx-SPI-MB Rev 2.0 Schematics
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Figure 25. Si838x-SPI-DC Rev 2.0 Schematics

Place C1 and C3 as
close to the Si838x
device as possible

GND2

GND1

VDD1

GND1

GND1

VDD1

GND2

GND2

GND2

GND2

MOSI_IN

NSS

SCLK

MISO

MOSI_THRU

GND2

VDD1

GND1

TP7
A2

TP3
NSS

J1

1

2

3

4

5

6

7

8

C14
NI

D1

YELLOW

R1833.0

R20
2K

R10
2K

TP9
A5

R28
2K

D5

YELLOW

C1
1uF

R12
2K

C4
NI

TP2
MOSI

TP6
A3

D4

YELLOW

R2
2K

TP4
SCLK

D8

YELLOW

R30
2K

TP10
A6

R24
2K

C9
NI

TP1
MISO

C3
NI

TP12
A8

C10
NI

R36
2K

R15
2K

C2
0.1uF

C13
NI

R1633.0

C8
NI

R34
2K

J2

1

2

3

4

5

6

7

8

D7

YELLOW

R6
2K

TP13
MOSI_THRU

R1733.0

C12
NI

C7
NI

C6
NI

R26
2K

TP8
A1

D3

YELLOW

R32
2K

R1333.0

C11
NID6

YELLOW

R4
2K

R8
2K

D2

YELLOW

TP5
A4

R22
2K

C5
NI

TP11
A7

I
S
O
L
A
T
I
O
N

U1

Si8380S

A4
4

MOSI
19

SCLK
17

A2
2

A1
1

A5
7

A6
8

NC
12

NC
11

A7
9

A8
10

SDITHRU
14

NC
13

A3
3

COMM
6

GND
15

MISO
20

COMM
5

VDD
16

NSS
18

NSS

SCLK

MOSI_IN

MISO

MOSI_THRU

Header goes on the
bottom of the DC PCB

Conn Socket goes on the top
of the DC PCB

GND1

GND1

VDD1

GND1

GND1
VDD1

GND1

VDD2

GND2

VDD2

GND2

MOSI_IN

NSS
SCLK

MOSI_THRU

MISO

GND2

GND1VDD1

VDD2
D9
BLUE

J8

CONN SOCKET 5x2

1
1

2
2

3
3

4
4

5
5

6
6

7
7

8
8

9
9

10
10

TP15
GND1

TP14
VDD1J5

CONN SOCKET 2x2/SM

1
1

3
3 2

2

4
4

R37
9.10K TP16

VDD2

R38
1K

J7

HEADER 2x2/SM

1
1

3
3 2

2

4
4

J9

CONN SOCKET 5x2

1
1

2
2

3
3

4
4

5
5

6
6

7
7

8
8

9
9

10
10

J6

CONN SOCKET 5x2

1
1

2
2

3
3

4
4

5
5

6
6

7
7

8
8

9
9

10
10

D10
AMBER

TP17
GND2NSS

MOSI_IN

MOSI_THRU

SCLK
MISO

Connectors

Si838x PLC output
Skyworks Solutions, Inc.   •   Phone [949] 231-3000   •   sales@skyworksinc.com   •   www.skyworksinc.com

206637C   •   Skyworks Proprietary Information   •   Products and Product Information are Subject to Change without Notice

29 July 9, 2024



Si834x/Si838xUSER GUIDE
Figure 26. Si834xSRC-SPI-DC Rev 2.0 Schematics
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Figure 27. Si834xSNK-SPI-DC Rev 2.0 Schematics
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6.  EVB Layout Files

6.1.  Si83xx-SPI-MB Rev 2.0 Layout Files

Figure 28. Si83xx-SPI-MB Rev 2.0 Top Silk (Top), Top Copper (Bottom)
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Figure 29. Si83xx-SPI-MB Rev 2.0 Bottom Copper (Top), Bottom Silk (Bottom)
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6.2.  Si838x-SPI-DC Rev 2.0 Layout Files

Figure 30. Si838x-SPI-DC Rev 2.0 Layout Files (Top Silk, Top Copper, Bottom Copper, Bottom Silk)
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6.3.  Si834xSRC-SPI-DC Rev 2.0 Layout Files

Figure 31. Si834xSRC-SPI-DC Rev 2.0 Layout Files (Top Silk, Top Copper, Bottom Copper, Bottom Silk)
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6.4.  Si834xSNK-SPI-DC Rev 2.0 Layout Files

Figure 32. Si834xSNK-SPI-DC Rev 2.0 Layout Files
(Top Silk, Top Copper, Bottom Silk, Bottom Copper)
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